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À propos de ce document
Nous vous remercions d'avoir installé HP Integrity Virtual Machines Manager (également nommé
VMMgr ou VM Manager). Ces notes de mise à jour décrivent les problèmes connus et d'autres
informations spécifiques à VM Manager version 3.50 (A.03.50).
VM Manager est un outil qui permet à l'administrateur système VM Host de créer, contrôler et
évaluer des machines virtuelles HP Integrity (Integrity VM). Il s'agit d'une interface utilisateur
graphique qui permet de visualiser et de configurer des machines virtuelles Integrity et le VM Host.
VM Manager est accessible à partir d'HP-UX System Management Homepage (HP SMH) ou par
le biais d'une intégration transparente avec des composants du logiciel de gestion VSE dans
HP Systems Insight Manager (HP SIM) sur un serveur de gestion centralisée (CMS, Central
Management Server).

Utilisateurs potentiels
Les utilisateurs potentiels de ce document sont les administrateurs système ou autres personnes
responsables de la maintenance d'un VM Host et de ses machines virtuelles. Ils doivent posséder
une bonne connaissance de l'administration système HP-UX à l'aide d'HP SMH ou HP SIM et du
produit HP Integrity Virtual Machines.

Nouveautés et modifications figurant dans cette édition
Ce document remplace l'Édition 2.0 des Notes de mise à jour de HP Integrity Virtual Machines
Manager. Il contient les notes de mise à jour relative à VM Manager version 3.5 (A.03.50).

Conventions typographiques
Ce guide utilise les conventions typographiques suivantes :
Titre de manuel Titre d’un manuel ou autre document.
Titre lié Titre qui est un lien hypertexte vers un manuel ou autre document.
http://www.hp.com Adresse de site Web qui est un lien hypertexte vers le site.
Commande Nom de commande ou phrase de commande qualifiée.
entrée
utilisateur

Commandes et texte que vous saisissez.

affichage
ordinateur

Texte affiché par l’ordinateur.

Entrée Le nom d’une touche du clavier. Notez que Retour et Entrée désignent la
même touche. Une séquence telle que Ctrl/A indique que vous devez maintenir
enfoncée la touche libellée Ctrl tout en appuyant sur la touche A.

variable Le nom d'une variable d'environnement, par exemple PATH ou errno.
valeur Une valeur susceptible d’être remplacée dans une commande ou une fonction

ou une information figurant sur un écran représentant plusieurs valeurs
possibles.

find(1) Page de manuel HP-UX. Dans cet exemple, « find » est le nom de la page
de manuel et « 1 » est la section de page de manuel.
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Plan du document
Ce document contient les chapitres suivants :

• Le Chapitre 1 (page 7) présente HP Integrity VM Manager et les fonctionnalités proposées
dans cette version.

• Le Chapitre 2 (page 11) décrit les problèmes connus dans cette version d'HP Integrity VM
Manager et, si possible, fournit des solutions de contournement.

Informations connexes
Vous pouvez télécharger la dernière version de ce document à l'adresse docs.hp.com.
Les documents connexes suivants peuvent également être téléchargés à partir du même site :

• Logiciel de gestion VSE version 4.0 - Guide de mise en route

• Logiciel de gestion VSE version 4.0 - Guide d'installation et de mise à jour pour HP-UX

• Gestion de HP Virtual Server Environment pour Integrity version 4.0 - Notes de mise à jour

• HP Virtualization Manager Version 4.0 Getting Started Guide

• HP Application Discovery Version 4.0 User's Guide

• HP Capacity Advisor version 4.0 - Guide d'utilisation

• HP Global Workload Manager version 4.0 - Guide d'utilisation

• HP Integrity Virtual Machines Manager version 3.5 - Guide de mise en route

• HP Integrity Virtual Machines version A.03.50 - Installation, configuration et administration

• HP Integrity Virtual Machines version A.03.50 - Notes de mise à jour

Historique de publication

Date de publicationVersion de VM Manager prise en
charge

Référence du document

Mai 2008A.03.50T8669–90012

Juin 2007A.03.00T2767-90058

Février 2006A.01.00T2767-90009-fr

Commentaires et suggestions
HP serait heureux de recevoir vos commentaires concernant ce document. Nous sommes désireux
de mettre à votre disposition une documentation correspondant réellement à vos besoins.
Vos commentaires et suggestions concernant les fonctionnalités de produits nous aideront à
développer les versions ultérieures du logiciel de gestion Virtual Server Environment. Utilisez
l'adresse de messagerie suivante pour faire part de vos commentaires directement à l'équipe de
développement du logiciel de gestion VSE : vse@hpuxweb.fc.hp.com.

REMARQUE : HP n'est pas en mesure de fournir un support produit par le biais de cette adresse
de messagerie. Pour obtenir de l'assistance concernant un produit, contactez votre représentant
de support technique HP, votre représentant clientèle HP ou votre revendeur HP agréé. Pour plus
d'informations sur les services de support technique, consultez le site Web à l'adresse
http://welcome.hp.com/country/fr/fr/support.html.

Pour d'autres moyens de contacter HP, reportez-vous au site Web de contact HP à l'adresse
http://welcome.hp.com/country/us/en/wwcontact_us.html.
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1 HP Integrity Virtual Machines Manager
Ce chapitre fournit une vue d'ensemble d'HP Integrity Virtual Machines Manager (VM Manager)
et décrit les nouvelles fonctionnalités proposées dans la version 3.5 (A.03.50).

HP Integrity Virtual Machines Manager
HP Integrity Virtual Machines Manager (VM Manager) est l'interface utilisateur graphique (GUI)
que vous utilisez dans votre navigateur pour gérer les ressources HP Integrity Virtual Machines
(Integrity VM). VM Manager vous permet de créer, configurer et gérer des machines virtuelles.
Vous pouvez afficher toutes les machines virtuelles d'un VM Host et leurs ressources affectées, ainsi
que toutes les ressources assignées à une machine virtuelle ou un commutateur virtuel spécifique.
Au niveau du VM Host et de la machine virtuelle, VM Manager fournit des vues graphiques des
périphériques réseau et de stockage virtuel-à-physique. VM Manager obtient les informations
relatives aux ressources Integrity VM par le biais de fournisseurs Web-Based Enterprise Management
(WBEM) installés sur le VM Host.
Vous pouvez accéder à VMManager à partir d'un navigateur, à l'aide de l'un des deux composants
logiciels Web suivants :

• HP System Management Homepage (HP SMH)
VM Manager est installé séparément sur tout VM Host donné afin de gérer l'Integrity VM Host
et les machines virtuelles. Vous accédez à VM Manager à partir d'un navigateur qui peut se
connecter à ce VM Host par le biais du réseau.

• HP Systems Insight Manager (HP SIM)
VM Manager est installé dans le cadre du logiciel de gestion VSE (Virtual Server Environment)
qui s'exécute sous HP SIM sur un serveur réservé pour une utilisation en tant que serveur de
gestion centralisée (CMS, Central Management Server). Vous accédez à VM Manager à
partir d'un navigateur qui peut se connecter à ce CMS par le biais du réseau. Le CMS vous
permet de gérer plusieurs machines virtuelles Integrity (VM Hosts et chacune de leurs machines
virtuelles) découvertes par HP SIM. Dans cet environnement, VM Manager s'intègre de manière
transparente aux autres composants du logiciel de gestion VSE. Ces composants
d'interconnexion améliorent la fonctionnalité et la flexibilité de votre environnement de serveur
virtuel. Par exemple :

— HP Virtualization Manager fournit un cadre pour la visualisation de votre environnement
VSE. Tous les systèmes et charges de travail que vous êtes autorisé à voir sont affichés
sous forme graphique. Les relations hiérarchiques entre les systèmes et leurs métriques
d'utilisation actuelles peuvent être affichées sur un même écran. Virtualization Manager
vous permet de gérer une réserve de serveurs virtuels à systèmes d'exploitation multiples
et dimensionnables de manière dynamique. Vous utilisez Virtualization Manager pour
accéder à VM Manager afin d'afficher et de modifier des composants de VM Host ou
de machine virtuelle.

— HP Global Workload Manager (gWLM) est un gestionnaire de charges de travail à
systèmes multiples et à systèmes d'exploitation multiples qui sert de moteur de stratégie
intelligent dans l'environnement VSE. Il simplifie le déploiement des stratégies de gestion
de charge de travail automatisées sur plusieurs serveurs et procure des fonctionnalités
de contrôle et de création de rapports centralisées ainsi qu'une utilisation améliorée des
serveurs afin de vous aider à atteindre vos objectifs de niveau de service. L'utilisation de
VM Manager dans l'environnement VSE vous permet de créer, afficher et modifier des
stratégies gWLM pour les machines virtuelles.
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— HP Capacity Advisor est un logiciel de planification et d'analyse de capacité qui vous
permet d'optimiser les charges de travail sur votre environnement VSE afin d'utiliser au
mieux les ressources de serveurs. À partir de VM Manager, vous pouvez faire en sorte
que Capacity Advisor recueille et affiche des données pour un VM Host ou une machine
virtuelle spécifique. Certaines vues de VM Manager incluent des compteurs d'utilisation
qui affichent les données d'utilisation actuelle pour une ressource ; vous pouvez cliquer
sur le compteur pour afficher un rapport de données historiques plus détaillé. (Ces
compteurs sont visibles lors de l'utilisation de VM Manager avec HP SMH, mais vous ne
pouvez pas cliquer dessus pour obtenir un rapport Capacity Advisor.)

Les composants suivants sont également intégrés à l'environnement VSE :

— HP Application Discovery

— HP Instant Capacity Manager

— Fournisseurs WBEM et autres agents VSE
Pour plus d'informations sur les concepts et la terminologie VSE, y compris une liste complète
des composants de la suite VSE Management Software, reportez-vous au document Logiciel
de gestion VSE version 4.0 - Guide de mise en route.

Des informations relatives à HP SMH sont disponibles sur le site Web HP SMH suivant :
http://www.hp.com/go/smh
Des informations relatives à HP SIM sont disponibles sur le site Web HP SIM suivant :
http://www.hp.com/go/hpsim

Nouveautés dans cette version
La version 3.5 d'HP Integrity Virtual Machines Manager contient plusieurs nouvelles fonctionnalités
et capacités :

• Compatibilité avec HP Integrity Virtual Machines version 3.5 (A.03.50).

• Prise en charge de la création de machines virtuelles HP-UX 11i v3 et Linux à l'aide de
l'Assistant Create Virtual Machine. Pour plus d'informations, reportez-vous à l'aide de VM
Manager.

• Prise en charge des périphériques réseau et de stockage AVIO (Accelerated Virtual
Input/Output). Des périphériques de stockage AVIO peuvent être ajoutés à une nouvelle
machine virtuelle à l'aide de l'Assistant Create Virtual Machine. Pour ajouter des périphériques
à une machine virtuelle existante, sélectionnez Modify→Add Storage Device to Virtual
Machine... et Modify→Add Network Device to Virtual Machine.... Pour plus d'informations
sur l'Assistant Create Virtual Machine et le menu Modify, consultez l'aide de VM Manager
et le manuel HP Integrity Virtual Machines Manager version 3.5 - Guide de mise en route.
Pour plus d'informations sur AVIO, reportez-vous au manuel HP Integrity Virtual Machines -
Installation, configuration et administration.

• Prise en charge de l'affichage des journaux des événements de VM Host et de machine virtuelle
maintenus par le produit Integrity Virtual Machines sur le VM Host. View→Integrity VM log
for VM Host vous permet d'afficher les événements liés au VM Host et aux invités. L'affichage
est le résultat de l'exécution de la commande hpvmstatus -e sur le VM Host. Il inclut une
synthèse des commandes Integrity VM exécutées sur le VM Host, ainsi que d'autres informations.
View→Integrity VM log for VM vous permet d'afficher les événements liés aux machines
virtuelles sélectionnées. L'affichage est le résultat de l'exécution de la commande hpvmstatus
-e -P nom_mv sur le VM Host. Pour utiliser cette option, une ou plusieurs machines virtuelles
doivent être sélectionnées sur l'écran actuel.
Pour plus d'informations, voir l'aide de VM Manager et le document HP Integrity Virtual
Machines Manager version 3.5 - Guide de mise en route.
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REMARQUE : Lors de l'utilisation de VM Manager avec HP SMH, l'utilisation de l'une ou
l'autre de ces options de menu pour afficher les journaux des événements Integrity VM requiert
que vous soyez connecté à HP SMH avec des privilèges d'administrateur ou d'opérateur. Si
vous êtes connecté uniquement avec des privilèges d'utilisateur, toute tentative d'utilisation
d'une option de menu pour afficher les journaux des événements Integrity VM génère un
message d'erreur signalant que l'exécution de la commande hpvmstatus est impossible.
Pour plus d'informations sur les privilèges HP SMH, reportez-vous à la documentation HP SMH
disponible sur le site Web à l'adresse suivante (cliquez sur le lien Support and Documents) :
http://www.hp.com/go/smh
Lors de l'utilisation de VM Manager à partir d'HP SIM et du logiciel de gestion VSE, l'utilisation
de l'une ou l'autre de ces options de menu n'est pas limitée ; tout utilisateur autorisé à utiliser
VM Manager peut afficher les journaux des événements Integrity VM à l'aide de ces options
de menu.

• La suppression d'une machine virtuelle à l'aide de VM Manager depuis HP SIM et le logiciel
de gestion VSE provoque désormais la suppression de la machine virtuelle d'HP SIM. En outre,
lors de la création d'une machine virtuelle à l'aide de VM Manager, celui-ci initie une
réidentification du VM Host par HP SIM de sorte que la nouvelle machine virtuelle soit reconnue
et ajoutée à HP SIM.

REMARQUE : Le processus d'identification HP SIM peut prendre une ou deux minutes. Si
vous revenez à Virtualization Manager immédiatement après avoir créé une machine virtuelle,
celle-ci peut ne pas figurer dans la vue Virtualization Manager, mais elle apparaîtra
automatiquement une fois l'identification terminée. Pour plus d'informations sur un comportement
semblable entre les actions VM Manager et la vue Virtualization Manager, voir « Une machine
virtuelle supprimée peu après avoir été créée peut apparaître dans Virtualization Manager »
(page 13).
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2 Limitations de VM Manager et problèmes connus
Ce chapitre contient les informations suivantes dans les sections correspondantes :

SectionInformation

« Limitations et restrictions » (page 11)Limitations et restrictions

« Problèmes majeurs » (page 12)Principaux problèmes connus qui affectent la fonctionnalité
ou l'utilisation de VM Manager, et solutions de
contournement éventuelles

« Problèmes mineurs » (page 13)Problèmes connus mineurs qui n'affectent pas la
fonctionnalité ou l'utilisation de VM Manager de manière
significative, et solutions de contournement éventuelles

« Erreurs et omissions dans la documentation » (page 14)Problèmes et omissions connus dans la documentation de
VM Manager (y compris l'aide)

Les limitations ou problèmes spécifiques à HP SMH sont indiqués comme tels.

Limitations et restrictions
Cette section décrit les limitations ou restrictions applicables à cette version de VM Manager.

VM Manager ne prend pas totalement en charge les périphériques APA imbriqués
Integrity VM version 3.5 prend en charge les périphériques de support APA (Automatic Port
Aggregation) imbriqués pour les commutateurs virtuels, mais VM Manager version 3.5 ne les prend
pas totalement en charge. Un périphérique APA imbriqué est un groupement d'autres périphériques
APA. Par exemple, si lan900 est un périphérique APA composé des cartes d'interface réseau
physiques lan1 et lan2, et que lan901 est un périphérique APA composé des cartes d'interface
réseau physiques lan3 et lan4, les utilitaires de configuration réseau HP vous permettent de définir
un périphérique lan902 APA imbriqué composé de lan900 et lan901. VM Manager ne prend
pas totalement en charge un périphérique APA imbriqué tel que lan902 en tant que périphérique
de support pour un commutateur virtuel. VM Manager ne prend pas totalement en charge les
périphériques APA directement composés de cartes d'interface réseau physiques, tels que lan900
ou lan901.
Lorsque vous utilisez VM Manager pour créer un commutateur virtuel, VM Manager ne répertorie
pas les périphériques APA imbriqués (ou leurs constituents) en tant que périphériques de support
possibles. Si un commutateur virtuel secondé par un périphérique APA imbriqué existe déjà sur
un VM Host ou une machine virtuelle géré par VM Manager, celui-ci affiche le commutateur virtuel
sous les onglets Network de VM Host, VM Properties et Vswitch Properties en tant que périphérique
inconnu (à l'aide de l'icône de point d'interrogation, ). VM Manager affiche le nom de
périphérique LAN correct (tel que lan902), mais le périphérique n'est pas associé aux ressources
réseau physiques qui composent le périphérique APA.

Solution de contournement
Si vous souhaitez créer un commutateur virtuel qui utilise un périphérique de support APA imbriqué,
utilisez la commande hpvmnet d'Integrity VM. Pour plus d'informations sur cette commande,
reportez-vous au manuel HP Integrity Virtual Machines - Installation, configuration et administration.
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VM Manager ne prend pas totalement en charge les fichiers de périphériques virtuels
situés dans /hpap en tant que périphériques de support

Integrity VM version 3.5 prend en charge les fichiers spéciaux de périphériques virtuels situés dans
/hpap (introduits dans le logiciel HP StorageWorks Secure Path version 3.0F SP2) en tant que
périphériques de support pour le stockage virtuel ; toutefois, VM Manager ne prend pas totalement
en charge ces fichiers en tant que périphériques de support pour le stockage. Lorsque vous utilisez
VM Manager pour ajouter ou créer un périphérique de stockage sur une machine virtuelle, VM
Manager n'affiche pas les fichiers de périphériques dans /hpap comme périphériques de support
possibles. S'il existe déjà un périphérique de stockage virtuel utilisant un fichier spécial de
périphérique /hpap sur une machine virtuelle gérée par VM Manager, VM Manager l'affiche sous
les onglets Storage de VM Host et VM Properties en tant que périphérique inconnu (à l'aide de
l'icône de point d'interrogation, ). VM Manager affiche le nom de fichier spécial de périphérique
correct (par exemple /hpap/rdsk/hpap1), mais la zone représentant ce périphérique n'est pas
connectée aux zones qui représentent les périphériques de stockage physiques associés à ce fichier
spécial de périphérique virtuel. En règle général, VM Manager affiche correctement uniquement
les fichiers spéciaux de périphériques situés dans /dev.

Solution de contournement
Pour ajouter un périphérique de stockage virtuel qui utilise un fichier spécial de périphérique virtuel
dans /hpap à une machine virtuelle existante, utilisez la commande hpvmmodify d'Integrity VM.
Pour ajouter un tel périphérique à une nouvelle machine virtuelle, utilisez la commande
hpvmcreate. Pour plus d'informations sur ces commandes, reportez-vous au manuel HP Integrity
Virtual Machines - Installation, configuration et administration.

Les fournisseurs VM Integrity version 2.0 (et antérieures) ne fonctionnent pas avec
les services WBEM version 2.5 ou ultérieure

Les fournisseurs WBEM Integrity VM de version 2.0 ou antérieure sont incompatibles avec les
services HP WBEM pour HP-UX version 2.5 ou ultérieure. Si vous installez les services HP WBEM
pour HP-UX version 2.5 sur un VM Host où la version 2.0 ou antérieure d'un fournisseur Integrity
VM WBEM est installée, lorsque vous accédez à VM Manager, un message d'erreur provernant
du serveur WBEM du VM Host apparaît en haut de l'écran de VM Manager et aucune donnée
n'est disponible sur cet écran. Il s'agit du message d'erreur suivant :
An error occurred collecting data -- query failed. 
An error occurred communicating with WBEM: CIM_ERR_FAILED CIM_ERR_FAILED: A GENERAL ERROR
OCCURRED THAT IS NOT COVERED BY A MORE SPECIFIC ERROR CODE.: "PGS00200: NULL POINTER."

Pour gérer un VM Host avec VM Manager et le logiciel de gestion VSE, un fournisseur WBEM
Integrity VM est requis sur le VM Host. Les fournisseurs WBEM Integrity VM sont facultatifs sur les
machines virtuelles ; toutefois, HP vous recommande d'en installer un sur chaque machine virtuelle
sur un VM Host géré par VM Manager ou le logiciel de gestion VSE.

Solution de contournement
Si vous devez installer les services HP WBEM version 2.5 ou ultérieure sur une machine virtuelle,
mettez tout d'abord à niveau le fournisseur WBEM Integrity VM sur la machine virtuelle vers la
version 3.0 ou ultérieure. Si les services HP WBEM version 2.5 ou ultérieure sont requis sur un VM
Host, mettez à niveau Integrity VM vers la version 3.0 ou ultérieure.

Problèmes majeurs
Cette section décrit les problèmes connus qui affectent de manière significative la fonctionnalité
ou l'utilisation de VM Manager. Pour cette version, aucun problème majeur n'est identifié pour
VM Manager.

12 Limitations de VM Manager et problèmes connus

http://docs.hp.com/fr/allproducts.html#HP%20Integrity%20Virtual%20Machines
http://docs.hp.com/fr/allproducts.html#HP%20Integrity%20Virtual%20Machines


Problèmes mineurs
Cette section décrit les problèmes connus qui n'ont pas un impact significatif la fonctionnalité ou
l'utilisation de VM Manager. Des suggestions de contournement de ces problèmes sont proposées.

Une machine virtuelle supprimée peu après avoir été créée peut apparaître dans
Virtualization Manager

Lors de l'utilisation de VM Manager à partir d'HP SIM avec VSE, si vous créez une machine virtuelle
et que vous la supprimez avant qu'elle ait été identifiée par HP SIM, la machine virtuelle peut
apparaître dans Virtualization Manager, comme si elle n'avait pas été supprimée. L'apparence
de la machine virtuelle dans Virtualization Manager varie selon le moment où la suppression a eu
lieu durant le processus d'identification HP SIM.
Ce problème ne se présente pas lors de l'utilisation de VM Manager à partir d'HP SMH.

Solution de contournement
Lors de l'utilisation de VM Manager avec VSE pour créer une machine virtuelle, si vous décidez
de supprimer la machine virtuelle peu après l'avoir créée, patientez quelques minutes. Si la machine
virtuelle supprimée n'apparaît pas dans Virtualization Manager, supprimez de la vue HP SIM All
System. (À partir de la liste HP SIM Systems and Event Collections dans la zone de navigation
sur la gauche, sélectionnez All Systems. Pour plus d'informations, voir le document
HP Virtualization Manager Version 4.0 Getting Started Guide.)

REMARQUE : Un autre comportement incohérent entre les actions VM Manager et les vues
Virtualization Manager peut se présenter lorsque vous créez une machine virtuelle à l'aide de VM
Manager et que vous revenez immédiatement à Virtualization Manager. Si HP SIM n'a pas encore
terminé l'identification de la nouvelle machine virtuelle, celle-ci n'apparaît pas encore dans
Virtualization Manager. Toutefois, elle apparaît une fois le processus d'identification terminé (en
général après une ou deux minutes).

Les instructions Next Steps de l'Assistant Create Virtual Machine affichent des
commandes incorrectes

L'écran Next Steps qui apparaît après la création d'une machine virtuelle à l'aide de l'Assistant
VM Manager Create Virtual Machine contient des instructions d'accès à la console. Ces instructions
indiquent de manière incorrecte que vous devez spécifier l'option -F avec la commande
hpvmconsole.

Solution de contournement
Ne spécifiez pas l'option -F. Spécifiez la commande comme suit, où nom-mv est le nom de la
machine virtuelle :
hpvmconsole -P nom-mv

Les espaces imbriqués dans des données peuvent être affichés de manière incorrecte
dans certaines vues de VM Manager

Dû à un problème au niveau du client Java CIM, certains écrans (tels que celui affiché en
sélectionnant View→VM Manager Version Information...) affichent de manière incorrecte les
espaces imbriqués dans des champs de données. Tout ou une partie des espaces imbriqués peut
être omis. Par exemple, les chaînes de version affichées sur l'écran VM Manager Version peuvent
être affichées comme dans l'exemple suivant, dans lequel tous les espaces sont omis :
HPVMA.03.50clearcaseoptWedMar12200805h58m31sPDT

La même chaîne de version affichée correctement est la suivante :
HPVM A.03.50 clearcaseopt Wed Mar 12 2008 05h58m31s PDT
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Ce problème n'a été constaté que lors de l'utilisation de VM Manager à partir d'HP SMH. Il n'a
pas été constaté lors de l'utilisation de VM Manager à partir d'HP SIM avec le logiciel de gestion
VSE.

Solution de contournement
Quittez l'écran actuel et revenez-y ou, si le lien Refresh Data est présent sur l'écran que vous
affichez, cliquez dessus à une ou plusieurs reprises jusqu'à ce que les données s'affichent
correctement.

Erreurs et omissions dans la documentation
Cette section décrit les erreurs ou omissions présentes dans le document HP Integrity Virtual Machines
Manager version 3.5 - Guide de mise en route et dans l'aide de VM Manager.

La recherche dans l'aide ne fonctionne pas pour l'aide localisée affichée à partir
d'HP SMH

Comme avec l'aide localisée de l'environnement VSE, la fonctionnalité de recherche ne fonctionne
pas correctement pour l'aide VM Manager autonome (HP SMH) localisée. En revanche, la
fonctionnalité de recherche fonctionne correctement lorsque l'aide de VM Manager est affichée à
partir d'HP SIM avec VSE.

La page d'aide Summary de création de machine virtuelle affiche des informations
trompeuses

L'écran Summary est affiché par l'Assistant Create Virtual Machine une fois que vous avez spécifié
tous les paramètres et périphériques de la machine virtuelle créée. La page d'aide Summary
décrit de manière incorrecte la manière dont les commandes et la vérification d'erreur sont exécutées
lors de la création d'une machine virtuelle avec l'Assistant. Comme il est décrit correctement dans
le manuel HP Integrity Virtual Machines Manager version 3.5 - Guide de mise en route, lorsque
vous cliquez sur Finish, les deux commandes hpvmcreate répertoriées dans la zone Command
Preview sont exécutées. La première commande vérifie la disponibilité des ressources et autres
aspects connexes, sans créer la machine virtuelle. Si des erreurs ou des avertissements de
disponibilité des ressources sont retournés, ils sont signalés en haut de la page. Si aucun problème
n'est détecté, la deuxième commande crée la machine virtuelle. Si vous souhaitez créer la machine
virtuelle sans vérifier la disponibilité des ressources ou sans vous soucier des éventuels avertissements
de ressources attendus, activez la case à cocher Create VM even if resources are insufficient,
missing or unavailable en bas à gauche de la page. Par exemple, si cette case à cocher est
activée, vous pouvez créer une machine virtuelle qui utilise un disque physique déjà utilisé par
une autre machine virtuelle en cours d'exécution. En guise d'autres exemple, vous pouvez créer
une machine virtuelle pour laquelle vous avez spécifié un fichier de périphérique de stockage de
façon incorrecte. Vous pouvez résoudre ce genre de problème après la création de la machine
virtuelle et avant son démarrage.

La page d'aide Next Steps de création de machine virtuelle mentionne une
commande hpvmconsole incorrecte

L'écran Next Steps de l'Assistant Create Virtual Machine suit l'écran Summary. La page d'aide
Next Steps suggère de manière incorrecte que vous devez spécifier l'option -F avec la commande
hpvmconsole pour accéder à la console. N'incluez pas cette option avec la commande. Spécifiez
la commande comme suit, où nom-mv est le nom de la machine virtuelle :
hpvmconsole -P nom-mv

REMARQUE : Comme décrit dans « Les instructions Next Steps de l'Assistant Create Virtual
Machine affichent des commandes incorrectes » (page 13), l'écran Next Steps de VM Manager
affiche également la commande incorrecte.
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